





Master Threads

In addition to the automatic layout made possible while initially flowing text,
Master Threads can transform master pages from a simple starting point for
layout, into true dynamic page templates. When text frames are defined as
Master Threads, the text contained by them will automatically reflow into new
text frames any time the master page changes or the page side changes. This
means, you can drastically change the layout of your text by simply apply-
ing a different master page. With one click of the mouse, or by dragging a
master page onto a local page in your pages panel, you can rearrange your
layout! No more manually reflowing text when you see a need to change the

master page—even if your text does not fit the page margins!

Defining Master Threads
Defining master text frames as a Master Thread could not be easier. Just select
a text frame on a master page and select API > AutoFlow Pro > Define

Master Thread..., which will bring up the following dialog:

Label the Master Thread | EMaimextﬂcw ..........................................

Main text flow -

F P
[ Cancel )

Type in the Master Thread name or select a previously named one from the

drop-down menu. Repeat this procedure on all master pages on which text
of the same thread will be located. Once a master text frame is labeled with
a Master Thread label, the label name will appear attached to the top left of
every text frame in the thread. This is true both for the text frames on the

master page as well as the overridden text frames on local pages.
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Please note: There is a bug on some installations of Windows where it is not
possible to type a label name into the dialog. We have not yet been able to
identify what exact system configurations cause this problem. If you see this
problem, please download this script and run the script once. This should
solve the problem by reversing the structure of the combo-box in the dialog
when it is re-opened. The effects of the script should hold indefinitely.

Take care to run the script only once. Each subsequent run of the script will
cause the structure of the combo-box to be reversed. This reversal will either
fix, or break the functionality of the combo-box, depending on its previous

state.

The Master Thread labels can be hidden. To toggle the visibility of the labels,
select View > In-Tools > Hide Master Thread Labels

Hide Notes L | I |
Hide AutoFlow Settings
Hide Master Thread Labels
Hide Master Content Frame Labels

Using Master Threads

Once Master Threads are set up, you can lay out your book as usual. You don’t
need to do anything differently to ensure that your Master Threads flow cor-
rectly. If the story which uses your Master Thread Frames is set to AutoFlow
(see page 27 and page 35), the Master Thread Frames will be overridden (i.e.
transferred to the local page) automatically as needed. Manually overrid-
den text frames will keep their Master Thread status as well. The status of
the Master Thread Frames become apparent when page sides change, or the
applied master page changes. In either of these scenarios, the text which
flows through the Master Thread Frames will automatically reflow into new

Master Thread Frames taken from the current master page.


http://in-tools.com/downloads/FixComboBox.zip

Master Threads

When using Master Threads, there are two preference settings (see page 31)

which are important to note:

@Preseme Resizing on Master Frames
@ Reflow Master Frames When Side Changes

1. “Preserve Resizing on Master Frames” is an option which will keep the
dimensions of the text frame when reflowing the text into the new master
frames. This is important because the old frames are actually discarded when
the text content is reflowed. Very often text frames are resized to accommo-
date the text and you don’t want to lose those dimensions. It is important
to note that the sizing is only preserved if the two frames are considered
to be congruous. This is determined by examining the size and location of
the two original master frames. If the original Master Frame and the new
one into which the text is flowing are within one point of each other, they
are considered congruous, and the size will be transferred. Master Frames
are measured relative to the spine of the document, to preserve the layout
design of facing pages.

2. “Reflow Master Frames When Side Changes”: When the side of a
page changes in CS3 and later, an overridden master frame is not actually
detached from the master page. It is attached to a master item which doesn’t
really exist. When master pages are applied to a document page, the entire
master spread is applied to each page individually. You can look at it as if
every page has all the items of an entire master spread on it, but only the
items which corresponds to the current page side are actually visible. When
the page side changes, even overridden master items (even though they are
now within the visible bounds of the page) are still attached to the invisible
master page items which are outside the bounds of the page. This can result

in doubling of master items. If, for example, a recto page with overridden
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recto master items becomes a verso page, the overridden recto items will be

visible as well as the non-overridden verso ones.

AutoFlow Pro will eliminate these doubled frames by removing the overrid-
den one which is on the wrong page side, and overriding the corresponding
one on the current page side. If (for whatever reason) you want to preserve

these doubled up frames, you have the option of canceling this reflow.

nnm If you have a document which has text which should only
appear on either a recto or verso page, but there’s a chance for
page sides to change, it is advisable to create a master thread
which spans both pages. On the side which should not contain
the text, you should create the text frame too small to actually
hold any text. This will cause the text to “appear” and “disap-
pear” automatically as page sides change. You can place the
“blank” text frames in the page margins or on a hidden layer so

they will be out of the way.

Master Content Frames

AutoFlow Pro completes the concept of using master pages as dynamic tem-
plates by offering Master Content Frames. Just as Master Threads transform
the way text frames are automatically overridden and threaded as work pro-
gresses, so too, Master Content Frames transform the way graphics frames
hold content.

Master Content Frames set the size and position of graphic objects prior
to their placement on the page. As in Master Thread Frames, when master
pages are changed, the content of Master Content Frames will be transferred

to the new corresponding Master Content Frames. If the size or location of
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the graphic frames changes, the new size and location will be used. The new

frame fitting options will be honored as well.

The combination of Master Threads and Master Content Frames allows highly
structured layout to be set up in advance with multiple alternatives. Existing
layouts can be completely altered, with the text reflowing and the graph-
ics rearranging themselves to fit the new layout—totally automatically, by
simply applying a new master page. The application of Master Threads and
Master Content Frames to create dynamic master page templates will dramati-

cally increase your productivity!

Defining Master Content Frames

The process of defining Master Content Frames is very similar to the pro-
cess of defining Master Threads. Simply select a Frame or any object which
can contain graphics on a master page and select API > AutoFlow Pro >
Define Master Content Frame.... The labels are applied in the same way that
Master Thread labels are applied (see page 43), and the label will appear on
the top of the graphic frame as with master threads. The visibility is toggled
by selecting View > In-Tools > Hide/Show Master Content Frame Labels.

Using Master Content Frames

For Master Content Frames to be effectively used, each master page which
could possibly be used should have corresponding Master Content Frames.
The Master Content Frames on each master can have unique placement and
fitting options. Fitting options can be predefined using InDesign’s Frame Fit-
ting Options. If the fitting options do not match, the content will be refitted
to the new fitting options. If no fitting options are set, the content will be
positioned and scaled proportionally to the existing positioning and scaling.

AutoFlow Pro uses a sophisticated algorithm to determine how the content
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should be positioned within the frame. If no Frame Fitting Options are
defined, AutoFlow Pro will detimine whether the content is fit to the frame,

centered, or placed at a custom positon and magnification.

Content of Master Content Frames can be any object type which can exist in
frames. This includes native InDesign objects such as rectangles, polygons,

text frames, lines, groups, etc. It can include linked graphics as well.

If the master page is switched to a master page which does not contain a
corresponding Master Content Frame, the frame will be disconnected from

the master and remain in it’s current position.

nmm If you are designing a layout which has a variable number of
graphics, you can have the graphics “appear” and “disappear”
when master pages are changed. To accomplish this, create
a hidden layer and place the Master Content Frames on this
hidden layer, for any page where you do not want a particular
graphic content to show. The graphic content will then “pop in

and out” automatically when master pages change.
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Other Commands
Shrink Selected Frame(s)
Fit Selected Frame(s)

Disable AutoFlow Pro
Rebuild Current Story
Reflow Current Story

Force Recompose AutoFlow Pro Stories

Shrink Selected Frame(s)

“Shrink Selected Frame(s)” will simply fit the selected frame or frames to
the smallest size which will not cause the text to be overset. This is similar
to the Fit Frame to Content command, but it works with threaded frames—
even frames in the middle of a story. “Shrink Selected Frame(s)” is useful
for balancing multi-column text frames. The command is honors AutoFlow
settings. If the story is set to Resize Up or Resize from Center, those settings
will be honored when resizing the frame. Otherwise the text frame will be

resized at the bottom.

Fit Selected Frame(s)

This option is very similar to the Shrink Selected Frame(s). The only differ-
ence between the two commands, is that Fit Selected Frame(s) will either
shrink or expand the text frame as necessary to fit the maximum amount of

text without going beyond the page margins.

Disable AutoFlow Pro
This command gives the option to temporarily disable flowing on stories set

to AutoFlow. For detailed information please see page 29.
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Rebuild Current Story

This command is a very drastic way of getting AutoFlow Pro to recompose
a story. It will remove all text frames except the first one, and if possible,
will remove pages as well. After the text frames are removed, it will re-create
them using the settings applied to the story. This command only works if a

story is set to add text frames.

We recommend only using this command if it’s truly necessary. It can some-
times cause major changes to your document. Please refer to page 30 for
further details.

Reflow Current Story / Reflow Current Story String.

This command forces the currently selected story to be reflowed. The text
frames will be fit as they would be when flowed for the first time, and any
Master page links will be used to correct the applied master pages. For full

information, please see page 29.

Force Recompose AutoFlow Stories

This command is used to force AutoFlow Pro to “wake up”. Under normal
circumstances this command should not be needed. However sometimes
stories might not be properly fitted because AutoFlow Pro was disabled, or
the document was edited on a computer without AutoFlow Pro installed.
Selecting this command when the file comes back to a computer with
AutoFlow Pro installed will get things back in order. The “Recompose All
Stories” command which is standard to InDesign should also work, but this

command is more direct.
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Shortcuts
All AutoFlow Pro commands can be applied using keyboard shortcuts or
with Quick Apply.

e Quick Apply

g = lfull

@ Active Page Item>Full Text Flow

r:;l Active Page Item> Configure Column Flow

(= K5

r‘:il Active Paga [tem>AutoFlow Pro Preferences...

r:jl Active Page [tem=>Configure Reflective Defaults. ..

r;;] Active Page Item>Configure Stary Tools...

r::l Active Page [tem>Define AutoFlow Pro Styles...

r;;] Active Page Item>Disable AutoFlow Pro

r::l Active Page Item>Expand Frames and Pages Automatically

r:;l Active Page [tem>Force Recompose AutoFlow Stories

EARE,

To use quick apply, simply invoke the Quick Apply shortcut (Command/
Control Return) and start typing the name of the command. For example:
to set the current story to “Full Text Flow”, invoke Quick Apply and start
typing “Full..”” When Full Text Flow is highlighted, simply hit return to
apply it.

To create a keyboard shortcut for application of AutoFlow Pro commands,
open the Keyboard Shortcuts dialog (Edit > Keyboard Shortcuts...). Once
the dialog is opened, make sure “Active Page Item” is selected in the Product
Area drop-down. If you use a custom keyboard shortcut set, make sure your

set is selected.

Keyboard Shogtcuts

Set:
[ Harbs I-i-l ( New Set... j ( Delete Set )

Product Area: ( Save :J ( Show Set... )
[ Active Page Item I-S-l
ommands:
="

TR e ™ ™ el
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Now we're going to create a keyboard shortcut for the Fit Selected Frame(s)
command which will make it very easy to shrink and expand specific text
frames at need.

copwnd ra 3 @n. _g€s . M g
Expand Selected Space Before

Fit Selected Frame(s)

Flow Stories In String Order

Footnote Numbering Formats...

In the “Commands” list, we selected the Fit Selected Frame(s) command.

Current Shortcuts:
Default: Ctrl+Cmd+F

Type Shortcut Here

Remove |

New Shortecut: Context:
Ctrl+Cmd+H |rDefauIt l-ﬂ( Assign )

Currently Assigned to:
( Cancel ) E oK 3

Fit Selected Frameis)

We then type Control+Command+F (which is otherwise unused) into the
New Shortcut field and click “Assign”. Now we can use the shortcut to resize

the currently selected text frame or range of text frames.

Compatibility and Known Issues
AutoFlow Pro fully supports InDesign CS3 and InDesign CS4. AutoFlow Pro

will work under InDesign CS2, but it is not recommended. AutoFlow Pro
has been highly optimized for performance in CS3 and CS4. These optimi-
zations do not work well with CS2 and the performance under CS2 will be

drastically degraded. InDesign CS is not supported at all.



Compatibility and Known Issues

We recommend a minimum of 2 GB of RAM when AutoFlow Pro will be
used extensively, although it will work with InDesign’s minimum system

requirements.

Rotated text frames will not expand correctly and new ones will not be cre-

ated correctly when flowed to a new page.

Text frames on rotated spread views (in CS4) will expand correctly if the
text frame is vertical when viewed. New frames created if text is flowed to

the next page will not be created correctly.

Whether or not we will give high priority to working around these limita-
tions will depend upon the feedback we receive. So, if flowing rotated text

frames or rotated spread views are important in your workflow, please let us
know!

AutoFlow Pro Dependencies

AutoFlow Pro does not create plugin dependencies. This means there should
be no issues sharing documents created while using AutoFlow Pro with other
users who do not have AutoFlow Pro installed. All AutoFlow Pro settings will

be preserved within the document as well.

The only issue to watch out for, is when documents come back to an instal-
lation with AutoFlow Pro installed. If there are overset text frames, or text
frames which require reflow, there might be some layout changes when text

is recomposed (edited or reformatted).
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Scripting

Most of AutoFlow Pro’s commands can be accessed via scripting. Scripting
access to AutoFlow Pro is provided by sending custom events to the plugin.
To do this you must first get a reference to the AutoFlow Pro plugin. This
is done using the loadedScriptedPlugins document method. The loaded-
ScriptedPlugins method returns an Array. Therefore, to create a variable

which references AutoFlow Pro you'd write:

ExtendScript Code:
var autoFlowProPlugin = myDoc.loadedScriptedPlugins("autoflowpro")[0]

AppleScript Code:
tell myDoc

set autoFlowProPlugin to item 1 of (loaded scripted plugins label "autoflowpro")
end tell

Visual Basic Code:
Set autoFlowProPlugin = myDoc.LoadedScriptedPlugins("autoflowpro")[1]

Once you have a valid reference to AutoFlow Pro, you simply tell AutoFlow

Pro to handle a custom event:

ExtendScript Code:
autoFlowPro.handleScriptEvent (eventCode:String,[eventData:String],[delay:
integer]);

AppleScript Code:
tell autoFlowProPlugin

handle script event event code (String) [event data (String)] [delay (Integer)]
end tell

Visual Basic Code:
autoFlowPro.HandleScriptEvent (eventCode:String,[eventData:String],[delay:
integer])
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In the above code, the event code is the custom event which you tell
AutoFlow Pro to handle. The event data is the data sent to the event handler,
although not all events require event data. The delay in milliseconds is when
the event is sent. This argument is totally optional. If left out, the event will
be sent immediately. If it’s 0, it will be sent when InDesign becomes idle.

Otherwise it will be sent after the specified delay.

Event Codes
Below is a list of acceptable event codes along with the description of what

they do and the required event data (if any):

Please Note: The event codes and event data are case sensitive.

Event Code Description Event Data
externalSetAutoFlow | Applies AutoFlow Pro String of two comma
settings to the specified | separated items. The first
story or array of stories | item is the story id, while the
second item is the desired
setting. Acceptable settings
are: “None”, “Add” “Expand”,
“Full” “Down”, “Up”, and “Out”".
To set multiple stories, the
event data for each story
should be separated by a

colon.

Examples in ExtendScript:
To set story with id 291 to Full Text Flow:
autoFlowPro.handleScriptEvent ("externalSetAutoFlow","291,Full");

To set story with id 291 to Full Text Flow, and story 264 to Add Pages:
autoFlowPro.handleScriptEvent ("externalSetAutoFlow","291,Full:264,Add");
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Event Code

Description

Event Data

externalTriggerFlow

Forces AutoFlow Pro to
compose a story with
AutFlow Pro settings
applied. This command
is useful if you need the
text to be flowed before
proceeding in your script

It accepts a single story id as
a String

Example:

autoFlowPro.handleScriptEvent ("externalTriggerFlow","291");

externalShrinkFrame

Vertically shrinks the
text frame to the
smallest size possible
without causing the
text frame to become
overset

Accepts the id of the text
frame as a String. It can
accept ids of more than one
frame separated by a comma.

Example: (given a text frame with an id of 487)
autoFlowPro.handleScriptEvent ("externalShrinkFrame","487");

To shrink multiple text frames: (with ids 487 and 562)
autoFlowPro.handleScriptEvent ("externalShrinkFrame","487,562");

externalFitFrame

Fits the text frame to
the text. It will either
shrink the frame or
expand it down to the
bottom page margiin as
necessary.

Accepts the id of the text
frame as a String. It can
accept ids of more than

one frame separated by a
comma. Syntax is the same as
externalShrinkFrame
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Event Code

Description

Event Data

externalFlowStory

Will AutoFlow a story or
list of stories. If there

is an AutoFlow seeting
set, it will flow the text
based on the current
setting. Otherwise it will
add/fit the text frames

Accepts the id of the stroy as
a String. It can accept ids of
more than one story separated
by a comma. Syntax is the
same as externalShrinkFrame
with the exception that the id
must be a story id—not a text

as needed frame id
externalDisable Temporarily disables None
Autoflowing for the
whole document
externalEnable Re-enables the None
autoflowing after it has
been disabled
externalRecompose | Forces all AutoFlow Pro None

stories to recompose

externalLabelMasterThread

Sets a label for a Master
Thread

Comma separated string of
two items: the story id and
the Master Thread Label

Example: (given a story on amaster page with a
autoFlowPro.handleScriptEvent ("externalLabelM

n id of 291)
asterThread","291,Main Text");

externalLabelMasterContent

Sets a label for a Master
Content Frame

Comma separated string of
two items: the page item id

and the Master Content Label

Example: (given a graphic frame on a master page with an id of 723)
autoFlowPro.handleScriptEvent ("externalLabelMasterContent","723,Picture 1");
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Sample Script
Below is a sample script which will set the current story to Full Text Flow:

var doc = app.documents[0];
var story = app.selection[0].parentStory;
var id_as_string = String(story.id);
var autoFlowPro = doc.loadedScriptedPlugins ("autoflowpro™)[0];
if(autoFlowPro){// if AutoFlow Pro is not loaded, the item will be undefined
autoFlowPro.handleScriptEvent ("externalSetAutoFlow",id_as_string+",Full");
} else {
alert("AutoFlow Pro not loaded!");

b

Here’s the same script in AppleScript:

tell application "Adobe InDesign CS4"
set myStory to parent story of item 1 of selection
set theDocument to active document
tell theDocument
set myStoryID to id of myStory as string
set myEventString to myStoryID & ",Full"
set autoFlowProPluginList to loaded scripted plugins label "autoflowpro"
if length of items of autoFlowProPluginList is greater than 0 then
set autoFlowProPlugin to item 1 of autoFlowProPluginList
tell autoFlowProPlugin
handle script event code "externalSetAutoFlow" data (myEventString as
string)
end tell
end if
end tell
end tell




Addendum

Script Labels

APID, (and in turn AutoFlow Pro) makes extensive use of script labels for
tracking objects. If there is a script label applied to story, it will have the
AutoFlow Pro label added to the existing string when you use AutoFlow Pro
commands. If you must use script labels on stories, ideally you should use
private labels (used with the insert label and extract label methods). If you
must use the public labels you should append the existing labels instead of
simply replacing the existing ones. Otherwise you stand the risk of tram-

pling AutoFlow Pro settings specific to stories and/or frames.

In other words, always use:

myStoryOrPageltem.insertLabel("myCustomLabel")

or if absolutely necessary:

myStoryOrPageltem.label = myStoryOrPageltem.label+"myCustomLabel"

instead of:

myStoryOrPageltem.label = "myCustomLabel"

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic, it

requires “event processing”. This means that certain events trigger specific
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processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. Devel-
oping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine-grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for
the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.


http://www.rorohiko.com/wordpress/indesign-downloads/active-page-item-developer/
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use
of the In-Tools software and documentation which are provided to you by In-Tools
(collectively, the Software). By copying, installing, or otherwise using the Software,
you accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including
without limitation, ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions
contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials
All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement


http://www.in-tools.com/privacy.html
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shall grant you the license to use such Marks. All intellectual property rights in the
Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION OF
YOUR COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBIL-
ITY AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PART-
NERS, OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY
RESPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY
OR INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE, INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR
ANY LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS
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OPPORTUNITIES OF ANY KIND OR NATURE WHATSOEVER, ARISING IN
ANY MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO
THIS AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS OR TO
THE USE OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES
EQUALLY TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO
A BINDING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE
THE SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT
BE LIABLE TO YOU OR ANY OTHER THIRD PARTY FOR ANY OF THE DAM-
AGES SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or to
anational or resident of Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any other
country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S. Treasury
Department’s list of Specially Designated Nationals or the U.S. Commerce Depart-
ment’s Table of Denial Order. By downloading or using the Software, you are agreeing
to the foregoing and you are representing and warranting that you are not located in,

under the control of, or a national or resident of any such country or on any such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of Delaware. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. In-Tools may immediately terminate
the Agreement if you breach any representation, warranty, agreement or obligation
contained or referred to in the Agreement. Upon termination, you must dispose of the
Software and all copies or versions of the Software by destroying the Software. In-Tools
reserves the right to modify the Software at any time without providing notice to you.
In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE AND WEB SITE,
YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.




